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QIAGEN Sample and Assay Technologies

QIAGEN is the leading provider of innovative sample and assay technologies,
enabling the isolation and detection of contents of any biological sample. Our
advanced, high-quality products and services ensure success from sample to
result.

QIAGEN sets standards in:

M Purification of DNA, RNA, and proteins

M Nucleic acid and protein assays

B microRNA research and RNAI

M Automation of sample and assay technologies

Our mission is to enable you to achieve outstanding success and
breakthroughs. For more information, visit www.giagen.com.
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Kit Contents

UGT1A1 Pyro Kit (box 1/2)

UGT1AT1 Pyro Kit (24)
Catalog no. 970540
Number of reactions 24
PCR Primer mix UGT1A1 *28 24 ul
PCR Primer mix UGTTA1 *6 24 ul
Seq Primer UGTTAT1 *28 24 ul
Seq Primer UGT1AT *6 24 ul
PyroMark® PCR Master Mix, 2x 850 ul
CoralLoad® Concentrate, 10x 1.2 ml
H,O 3x1.9ml
Human Control DNA, 10 ng/ul 100 ul
Pyro Buffers and Reagents (box 2/2)
Buffers and Reagents
PyroMark Binding Buffer 10 ml
PyroMark Annealing Buffer 10 ml
PyroMark Denaturation Solution* 250 ml
PyroMark Wash Buffer, 10x 25 ml
Enzyme Mixture 1 vial
Substrate Mixture 1 vial
dATPaS 1180 ul
dCTP 1180 ul
dGTP 1180 ul
dTTP 1180 ul
Handbook 1

* Contains sodium hydroxide.
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Shipping and Storage

The UGT1A1 Pyro Kit is shipped in two boxes. The UGT1A1 Pyro Kit (box 1/2) is
shipped on dry ice. PyroMark PCR Master Mix, CoralLoad Concentrate, control
DNA, and all primers should be stored at =15 to —25°C upon arrival.

The Pyro Buffers and Reagents (box 2/2) containing buffers, Enzyme Mixture,
Substrate Mixture, dATPaS, dCTP, dGTP, and dTTP (the reagents for
Pyrosequencing® analysis) is shipped on cool packs. These components should
be stored at 2-8°C upon arrival. To minimize loss of activity, it is advisable to
keep both the enzyme mixture and the substrate mixture in the vials supplied.

Reconstituted enzyme and substrate mixtures are stable for at least 5 days at
2-8°C. Reconstituted enzyme and substrate mixtures can be frozen and stored
in their vials at =15 to —25°C. Frozen reagents should not be subjected to more
than 3 freeze—thaw cycles.

Important: Nucleotides should not be frozen.

The UGT1AT1 Pyro Kit is stable until the kit expiration date when stored under
these conditions.

Product Use Limitations

The UGT1AT1 Pyro Kit is intended for molecular biology applications. This
product is not intended for the diagnosis, prevention, or treatment of a disease.

We recommend all users of QIAGEN® products to adhere to the NIH guidelines
that have been developed for recombinant DNA experiments, or to other
applicable guidelines.

Safety Information

When working with chemicals, always wear a suitable lab coat, disposable
gloves, and protective goggles. For more information, please consult the
appropriate material safety data sheets (MSDSs). These are available online in
convenient and compact PDF format at www.qgiagen.com/Support/MSDS.aspx
where you can find, view, and print the MSDS for each QIAGEN kit and kit
component.
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The following risk and safety phrases apply to components of the UGTTAT Pyro
Kit.

PyroMark Denaturation Solution

Contains sodium hydroxide: Irritant. Risk and safety phrases:* R36/38,
S26-36/37/39-45

24-hour emergency information

Emergency medical information in English, French, and German can be
obtained 24 hours a day from:

Poison Information Center Mainz, Germany
Tel: +49-6131-19240

Quality Control

In accordance with QIAGEN's ISO-certified Quality Management System, each
lot of the UGT1A1 Pyro Kit is tested against predetermined specifications to
ensure consistent product quality.

* R36/38: Irritating to eyes and skin; S26: In case of contact with eyes, rinse immediately with
plenty of water and seek medical advice; S36: Wear suitable protective clothing; S37: Wear
suitable gloves; S39: Wear eye/face protection; S45: In case of accident or if you feel unwell,
seek medical advice immediately (show the label where possible).
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Introduction

The UGT1AT1 Pyro Kit is used for genotyping of the allele variant *28 (for
distinguishing between 6 and 7 TA repeats) and allele variant *6 (for
distinguishing between G and A genotype) of the human UGT1A1 gene. The kit
consists of two assays: one for genotyping of allele variant *28 and the second
for genotyping of allele variant *6 (Figure 1). The two regions are amplified
separately by PCR and sequenced through the defined region. Sequences
surrounding the defined positions serve as normalization and reference peaks
for genotyping and quality assessment of the analysis.

The product consists of a PCR primer mix and a sequencing primer for each
assay. The primers are delivered in solution. Each vial contains 24 ul of each
primer or primer mix.

Note: The allele variant *28 is sequenced in reverse orientation and the allele
variant *6 in forward orientation.

FPB
UGT1A1*28
CGG[TA]TATATA <—— <4
Seq RP
FP Seq
> ——> CA/GGAGCA
UGT1A1*6
RPB

Figure 1. lllustration of the UGT1A1 assays. The sequence indicated is the analyzed
sequence with polymorphic nucleotides indicated by square brackets or slash. Part of the TA
repeats analyzed with the UGT1A1 *28 assay are covered by the sequencing primer. FP, FPB:
Forward PCR primers (B indicates biotinylation); RP, RPB: Reverse PCR primers (B indicates
biotinylation); Seq: Sequencing primers.

Principle and procedure

The workflow on page 8 illustrates the assay procedure. After PCR using primers
targeting allele variants *28 and *6, the amplicons are immobilized on
Streptavidin Sepharose® High Performance beads. Single-stranded DNA is
prepared, and the corresponding sequencing primers anneal to the DNA. The
samples are then analyzed on the PyroMark Q24 System using a run setup file
and a run file (see “Protocol 6: Analysis of a PyroMark Q24 Run”, page 26, and
Appendix A, page 31).
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Workflow of UGT1A1 Pyro procedure

Assay and run setup Sample preparation
Assay file setup (Appendix A) PCR (Protocol 2)
\
v Immobilization (Protocol 3)
\
Run file setup (Protocol 1) Preparation of samples (Protocol 4)

\/

PyroMark Q24 run (Protocol 5)
v
Analysis of PyroMark Q24 run (Protocol 6)

\/
Report
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Equipment and Reagents to Be Supplied by User

When working with chemicals, always wear a suitable lab coat, disposable
gloves, and protective goggles. For more information, consult the appropriate
material safety data sheets (MSDSs), available from the product supplier.

M DNA isolation kit (see “DNA isolation”, page 10)
Pipets (adjustable)

Sterile pipet tips (with filters for PCR setup)
Benchtop microcentrifuge

Thermal cycler and appropriate PCR tubes

Streptavidin Sepharose High Performance (GE Healthcare, cat. no.
17-5113-01; www.gelifesciences.com)

PyroMark Q24 (cat. no. 9001514)

PyroMark Q24 Software (cat. no. 9019062)

PyroMark Q24 Plate (cat. no. 979201)

PyroMark Q24 Cartridge (cat. no. 979202)

PyroMark Q24 Vacuum Workstation (cat. no. varies depending on region,
see “Ordering Information”, page 33)

Plate mixer for immobilization to beads (see “Recommended plate mixers”,
page 11)

Heating block capable of attaining 80°C

24-well PCR plate or strips

Strip caps

High-purity water (Milli-Q® 18.2 MQ x cm or equivalent)

Note: Sufficient water is provided in the product to dissolve the Enzyme
Mixture and the Substrate Mixture, for immobilization, and for PCR;
additional high-purity water is required to dilute PyroMark Wash Buffer,
10x.

M Ethanol (70%)*

* Do not use denatured alcohol, which contains other substances such as methanol or
methylethylketone.
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Important Notes

General precautions
The user should always pay attention to the following:

B The components of this product are sufficient to perform the 24 reactions in
5 independent runs.

B Use sterile pipet tips (with filters for PCR).

M Store and extract positive materials (specimens, positive controls, and
amplicons) separately from all other reagents, and add them to the
reaction mix in a spatially separated facility.

B  Thaw all components thoroughly at room temperature (15-25°C) before
starting an assay.

B When thawed, mix the components (by pipetting repeatedly up and down
or by pulse vortexing) and centrifuge briefly.

M Failed results are not a basis for judgment of genotype.

Sample material
All samples must be treated as potentially infectious material.

Specimen material is human DNA extracted from blood or formalin-fixed,
paraffin-embedded samples.

Samples from humans undergoing heparin treatment must not be used. Blood
samples that have been collected in tubes containing heparin as an
anticoagulant should not be used. Heparin affects the PCR.

DNA isolation

The kits from QIAGEN shown in Table 1 are recommended for DNA
purification from the indicated human sample types for use with the UGTTA1

Pyro Kit. Carry out the DNA purification according to the instructions in the kit
handbooks.
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Table 1. DNA purification kits recommended for use with the UGT1A1
Pyro Kit

Catalog number
Sample material Nucleic acid isolation kit (QIAGEN)
Blood QIAamp® DSP DNA Blood Mini Kit 61104
Paraffin-embedded QAcamp DNA FFPE Tissue Kit (50) 56404
tissue EZ1® DNA Tissue Kit (48) 953034

Recommended plate mixers

The plate mixers shown in Table 2 are recommended for use with the UGT1A1
Pyro Kit.

Table 2. Plate mixers recommended for use with the UGT1A1 Pyro Kit

Manufacturer  Product Catalog number
Basic mixer 5355 000.011
Eppendorf Thermoblock for MTP 5363 000.012
Adapter plate for 96 x 0.2ml PCR
tubes to insert in blocks for 5363 007.009
microtiter plates
Vari ® Toloshak 51410
ariomag® Teleshake
H+P 9 (115V = 51410 U)
Labortechnik
Gmbh 51110

Variomag Monoshake
(115V =51110 V)

Controls

Human control DNA is included in the kit as a positive control for PCR and
sequencing reactions.

In addition, a negative control (without template DNA) should always be
included.
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Protocol 1: Run Setup for the PyroMark Q24 System

Things to do before starting

B Create an Assay Setup as described in Appendix A. This needs to be done
only once, before running the UGT1A1 assay for the first time (see
Appendix A, page 31).

Procedure
1. Click U in the toolbar.

A new run file is created.

2. Enter the run parameters (see “Run parameters”, page 13).

3. Set up the plate by adding assays for allele variant *28 and allele
variant *6 to wells corresponding to the samples to analyze.
A negative sample (without DNA) and a control DNA are recommended as
controls.

4. When the run is set up and ready to run on the PyroMark Q24,
print a list of required volumes of enzyme mix, substrate mix, and
nucleotides, and the plate setup. Select “Pre Run Information” from
the “Tools” menu and, when the report appears, click =.

5. Close the run file and copy it to a USB stick (supplied with the
system) using Windows® Explorer.

The printed Pre Run Information can be used as a template for the sample
set up (see “Protocol 3: Immobilization of PCR Products to Streptavidin
Sepharose High Performance Beads”, page 17).

To run the plate on the PyroMark Q24, see “Protocol 5: Running the
PyroMark Q24 System”, page 23.

.|
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Run parameters

Run name: The name of the run is given when the file is saved.
Renaming the file also changes the name of the run.

Instrument method: Select the instrument method according to the
cartridge that will be used for the run; see the
instructions supplied with the products.

Plate ID: Optional: Enter ID of the PyroMark Q24 Plate.

Bar code: Optional: Enter a bar code number for the plate or, if
you have a bar code reader connected to your
computer, place the mouse cursor in the “Barcode”
text box (by clicking the box) and scan the bar code.

Kit and Reagent ID: Optional: Enter the lot number for the UGT1A1 Pyro
Kit to be used. The lot number can be found on the
product label.

Note: We recommend entering both the reagent ID
and the kit ID so that any unexpected problems with
the reagents can be traced.

Run note: Optional: Enter a note about the contents or purpose
of the run.

Add assay files
To add an assay to a well, you can either:
B Right-click the well and select “Load Assay” from the context menu.

M Select the assay in the shortcut browser, and click and drag the assay to the
well.

A well is color-coded according to the assay loaded to the well.

Enter sample IDs and notes
To enter a sample ID or note, select the cell and enter the text.

To edit a sample ID or note, either select the cell (the current contents will be
selected) or double-click the cell.
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Protocol 2: PCR Using the Reagents Supplied with
the UGT1A1 Pyro Kit

This protocol is for PCR amplification of a region for genotyping of allele variant
*28 and a separate PCR amplification of a region for genotyping of allele
variant *6 using the UGT1A1 Pyro Primers.

Important points before starting

B The HotStarTag® DNA Polymerase in the PyroMark PCR Master Mix
requires an activation step of 15 min at 95°C.

B Set up all reaction mixtures in an area separate from that used for DNA
purification, adding template DNA to the PCR, PCR product analysis, or
preparation of samples prior to Pyrosequencing analysis.

B Use disposable tips containing hydrophobic filters to minimize cross-
contamination.

Things to do before starting

B Before opening the tubes with PCR primers, centrifuge briefly to collect
contents at the bottom of the tubes.

M Adjust the concentration of the sample DNA, if necessary, to 0.4-2 ng/ul.

Procedure

1. Thaw all necessary components.
Mix well before use.

2. Prepare a reaction mix for each PCR primer set according to Table 3.

The reaction mix typically contains all of the components needed for PCR
except the sample.

Prepare a volume of reaction mix greater than that required for the total
number of PCR assays to be performed.
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Table 3. Preparation of reaction mix for each PCR primer mix

Component Volume/reaction
PyroMark PCR Master Mix, 2x 12.5 ul
CoralLoad Concentrate, 10x 2.5 ul

PCR Pr!mer m!x UGT1AT1 allele var!an’r *28 or 1.0

PCR Primer mix UGT1A1 allele variant *6

Water (supplied) 4.0 ul
Total volume 20.0 ul

3. Mix the reaction mix thoroughly, and dispense 20 ul into each PCR
tube.

It is not necessary to keep PCR tubes on ice since HotStarTag DNA
Polymerase is inactive at room temperature.

4. Add 5 ul template DNA (2-10 ng of genomic DNA) to the individual
PCR tubes (see Table 4), and mix thoroughly.
A negative control (without template DNA) should always be included.

Table 4. Preparation of PCR

Component Volume/reaction
Reaction mix 20 ul
Sample DNA 5 ul
Total volume 25 pl
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5. Program the thermal cycler according to the manufacturer’s
instructions, using the conditions outlined in Table 5.

Table 5. Optimized cycling protocol

Comments
Initial activation 15 min 95°C HotStarTag DNA
step: Polymerase is activated

by this heating step.
3-step cycling:

Denaturation 20 s 95°C
Annealing 30s 53°C
Extension 20 s 72°C

Number of cycles 42

Final extension: 5 min 72°C

6. Place the PCR tubes in the thermal cycler and start the cycling
program.
7. After amplification, proceed with “Protocol 3: Immobilization of PCR

Products to Streptavidin Sepharose High Performance Beads”, page
17.
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Protocol 3: Immobilization of PCR Products to
Streptavidin Sepharose High Performance Beads

This protocol is for immobilization of template DNA to Streptavidin Sepharose
High Performance (GE Healthcare) prior to analysis on the PyroMark Q24
System.

Things to do before starting

M Allow all required reagents and solutions to reach room temperature
(15-25°C) before starting.

Procedure
1. Gently shake the bottle containing Streptavidin Sepharose High
Performance until it is a homogeneous solution.

2. Prepare a master mix for DNA immobilization according to Table 6.
Prepare a volume 10% greater than that required for the total number of
reactions to be performed.

Table 6. Master mix for DNA immobilization

Component Volume/sample
Streptavidin Sepharose High Performance 2 ul
PyroMark Binding Buffer 40 ul
Water (supplied) 28 ul
Total volume 70 ul

3. Add 70 ul of the master mix to wells of a 24-well PCR plate (or strips)
as predefined in the run setup (see “Protocol 1: Run Setup for the
PyroMark Q24 System”, page 12).

4. Add 10 pl of biotinylated PCR product from Protocol 2 to each well
containing master mix as predefined in the run setup (see
“Protocol 1: Run Setup for the PyroMark Q24 System”, page 12).

The total volume per well should be 80 ul after addition of the master mix
and PCR product.

5. Seal the PCR plate (or strips) using strip caps.
Ensure that no leakage is possible between the wells.
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6. Agitate the PCR plate at room temperature (15-25°C) for 5-10 min at
1400 rpm.
During this step, prepare the PyroMark Q24 Vacuum Workstation for
sample preparation as described in the PyroMark Q24 User Manual.

7. Proceed immediately with “Protocol 4: Preparation of Samples Prior
to Pyrosequencing Analysis on the PyroMark Q24 System”, page 19.
Sepharose beads sediment quickly. Capturing of the beads must take place
immediately following agitation.

If more than T min has elapsed since the plate (or strips) was agitated,
agitate again for 1 min before capturing the beads.

___________________________________________________________________________________________________________________________________________________________|
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Protocol 4: Preparation of Samples Prior to
Pyrosequencing Analysis on the PyroMark Q24
System

This protocol is for preparation of single-stranded DNA and annealing of the
sequencing primer to the template prior to Pyrosequencing analysis on the
PyroMark Q24 System.

Important points before starting

B Before opening the tubes with sequencing primers, centrifuge briefly to
collect contents at the bottom of the tubes.

B Add the 2 different sequencing primers in the same pattern as predefined
for the plate in the run setup (see “Protocol 1: Run Setup for the PyroMark
Q24 System”, page 12), depending on the region of analysis (allele variant
*28, or allele variant *6).

Things to do before starting

M Place the PyroMark Q24 Plate Holder on a heating block at 80°C for use in
step 17.

M PyroMark Wash Buffer is supplied as a 10x concentrate. Before using for
the first time, add high-purity water to 25 ml 10x PyroMark Wash Buffer to
achieve a final volume of 250 ml and obtain a Tx working solution.

Note: The 1x PyroMark Wash Buffer working solution is stable at 2-8°C
until the marked expiration date.

Procedure

1. Dilute a sufficient amount of each sequencing primer, Seq Primer
UGT1A1 *28 and Seq Primer UGT1A1 *6, in PyroMark Annealing
Buffer as shown in Table 7.

Prepare a volume of diluted sequencing primer greater than that required
for the total number of samples to be sequenced (for the number of
samples + one extra).

___________________________________________________________________________________________________________________________________________________________|
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2.

4,

20

Table 7. Example of dilution of the sequencing primers

Volume for

Component Volume/sample 9 + 1 reactions
Seq Primer UGT1A1 *28
or 0.8 ul 8 ul

Seq Primer UGT1A1 *6

PyroMark Annealing
Buffer 24.2 ul 242 ul

Total volume 25.0 ul 250 ul

Add 25 pl of diluted sequencing primer to each well of the PyroMark
Q24 Plate according to the run setup (see “Protocol 1: Run Setup for
the PyroMark Q24 System”, page 12).

Keep one of the PyroMark Q24 Plate Holders (supplied with the PyroMark
Q24 Vacuum Workstation) at room temperature (15-25°C), and use it as
support when preparing and moving the plate.

Place the PCR plate (or strips) from Protocol 3 and the PyroMark Q24
Plate on the worktable (see Figure 2).

Ensure that the plate is in the same orientation as when samples were

loaded.

Figure 2. Placement of PCR plate (or strips) and PyroMark Q24 plate on the
vacuum workstation.

Apply vacuum to the vacuum tool by opening the vacuum switch.
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5. Carefully lower the filter probes into the PCR plate (or strips) to
capture the beads containing immobilized template. Hold the probes
in place for 15 s. Take care when picking up the vacuum tool.

Sepharose beads sediment quickly.

If more than 1 min has elapsed since the plate (or strips) was agitated,
agitate again for 1T min before capturing the beads.

6. Transfer the vacuum tool to the trough containing 40 ml 70% ethanol
(Figure 2). Flush the filter probes for 5 s.

7. Transfer the tool to the trough containing 40 ml Denaturation
Solution (Figure 2). Flush the filter probes for 5 s.

8. Transfer the vacuum tool to the trough containing 50 ml Wash Buffer
(Figure 2). Flush the filter probes for 10 s.

9. Raise the vacuum tool up and back, beyond 90° vertical, for 5 s to
drain liquid from the filter probes (Figure 3).

Figure 3. lllustration of the vacuum tool raised to beyond 90° vertical.

10. While the vacuum tool is held over the PyroMark Q24 Plate, close the
vaccum switch on the tool (Off).

11. Release the beads in the plate containing the Seq Primers by shaking
the tool gently from side to side.

12. Transfer the vacuum tool to the trough containing high-purity water
(Figure 2) and agitate the tool for 10 s.

13. Wash the filter probes by lowering the probes into high-purity water
(Figure 2) and applying vacuum. Flush the probes with 70 ml
high-purity water.

14. Raise the tool up and back, beyond 90° vertical, for 5 s to drain
liquid from the filter probes (Figure 3).

15. Close the vacuum switch on the tool (Off), and place the tool in the
Parking (P) position.
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16. Turn off the vacuum pump.

At the end of a working day, liquid waste, and remaining solutions should
be discarded and the PyroMark Q24 Vacuum Workstation should be
checked for dust and spillage (see Appendix B, page 32).

17. Heat the PyroMark Q24 Plate with the samples at 80°C for 2 min
using the prewarmed PyroMark Q24 Plate Holder.

18. Remove the PyroMark Q24 Plate from the plate holder, and let the
samples cool to room temperature (15-25°C) for 5-10 min.

19. Proceed with “Protocol 5: Running the PyroMark Q24 System”, page
23.
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Protocol 5: Running the PyroMark Q24 System

This protocol describes the loading of reagents into the PyroMark Q24
Cartridge, and starting and finishing a run on the PyroMark Q24. For detailed
description on how to set up a run, see the PyroMark Q24 User Manual.

Important point before starting

B The Pre Run information report, found in the “Tools” menu at run setup
(see “Protocol 1: Run Setup for the PyroMark Q24 System”, page 12),
provides information about the volume of nucleotides, enzyme, and
substrate buffer needed for a specific assay.

Procedure

1. Dissolve each of the freeze-dried enzyme and substrate mixtures in
620 pl each of water (supplied).

2. Mix by swirling the vial gently. Do not vortex!
To ensure that the mixture is fully dissolved, leave it at room temperature
(15-25°C) for 5-10 min. Make sure that the solution is not turbid before
filling the PyroMark Q24 Cartridge. If the reagents are not to be used
immediately, place the reagent vials on ice* or in a refrigerator.

3. Allow the reagents and the PyroMark Q24 Cartridge to reach
ambient temperature (20-25°C).

4. Place the PyroMark Q24 Cartridge with the label facing you.

5. Load the PyroMark Q24 Cartridge with the appropriate volumes of
nucleotides, enzyme, and substrate mixes according to Figure 4.

Make sure that no air bubbles are transferred from the pipet to the
cartridge.

* When working with chemicals, always wear a suitable lab coat, disposable gloves, and
protective goggles. For more information, consult the appropriate material safety data sheets
(MSDSs), available from the product supplier.
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11.

12.

13.
14.

15.
16.
. Open the cartridge gate and remove the reagent cartridge by lifting

17

18.
19.

20.

24

Figure 4. lllustration of the PyroMark Q24 Cartridge, as seen from above. The
annotations correspond to the label on the reagent vials. Add enzyme mixture (E),
substrate mixture (S), and nucleotides (A, T, C, G) according to the volume information
given in the Pre Run information report, found in the “Tools” menu at run setup.

Open the cartridge gate and insert the filled reagent cartridge with
the label facing out. Push the cartridge in fully and then push it
down.

Ensure the line is visible in front of the cartridge and close the gate.

Open the plate-holding frame and place the plate on the heating
block.

Close the plate-holding frame and the instrument lid.

. Insert the USB stick (containing the run file) into the USB port at the

front of the instrument.

Do not remove the USB stick before the run is finished.

Select “Run” in the main menu (using the ~ and ~ screen buttons)
and press “OK”.

Select the run file using the « and v screen buttons.

To view the contents of a folder, select the folder and press “Select”. To go
back to the previous view, press “Back”.

When the run file is selected, press “Select” to start the run.

When the run is finished and the instrument confirms that the run
file has been saved to the USB stick, press “Close”.

Remove the USB stick.
Open the instrument lid.

it up and pulling it out.
Close the gate.

Open the plate-holding frame and remove the plate from the
heating block.

Close the plate-holding frame and the instrument lid.
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21. Discard the plate and clean the cartridge, as per the instructions in
the product sheet supplied with the cartridge.
22. Analyze the run according to “Protocol 6: Analysis of a PyroMark

Q24 Run”, page 26.
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Protocol 6: Analysis of a PyroMark Q24 Run

This protocol describes the genotyping analysis of a finished UGT1A1 run using
PyroMark Q24 Software.

Procedure

1. Insert the USB stick (containing the processed run file) into the
computer’s USB port.

2. Move the run file from the USB stick to the desired location on the
computer using Windows Explorer.

3. Open the run file in AQ mode of PyroMark Q24 Software either by
selecting “Open” in the “File” menu or by double-clicking the file ()
in the shortcut browser.

4. To analyze the run and get an overview of the results, click one of
the Analyze buttons.

i Analyze all wells.
P Analyze the selected well.

For more details on how to analyze a run, see the PyroMark Q24 User
Manual.

5. To generate a report, select “SNP Full Report” or “SNP Overview
Report” in the “Reports” menu.

For reliable results, we recommend single peak heights above 30 RLU. Set
30 RLU as the “required peak height for passed quality” in assay setup (see
Appendix A, page 31, and the PyroMark Q24 User Manual).

The Pyrogram® should always be compared to the histogram, which can be
displayed by a right-click in the Pyrogram window. The measured peaks
should match the height of the histogram bars.
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Representative results

Representative Pyrogram results are shown in Figures 5-8.
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Figure 5. Pyrogram trace obtained after analysis of a sample with —/- (TA6/TA6)
genotype when analyzed for allele variant *28.
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Figure 6. Pyrogram trace obtained after analysis of a sample with —/TA (TA6/TA7)
genotype when analyzed for allele variant *28.
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Figure 7. Pyrogram trace obtained after analysis of a sample with TA/TA (TA7/TA7)
genotype when analyzed for allele variant *28.
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Figure 8. Pyrogram trace obtained after analysis of samples with a G/G genotype
when analyzed for allele variant *6.
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Troubleshooting Guide

This troubleshooting guide may be helpful in solving any problems that may
arise. For more information, see also the Frequently Asked Questions page at
our Technical Support Center: www.qgiagen.com/FAQ/FAQList.aspx. The
scientists in QIAGEN Technical Services are always happy to answer any
questions you may have about either the information and protocols in this
handbook or sample and assay technologies (for contact information, see back
cover or visit www.giagen.com).

Refer to the PyroMark Q24 User Manual for general troubleshooting of the
instrument.

Comments and suggestions

Signals in the no template control (negative control)

a) Cross-talk between Signal from one well is detected in a neighboring
wells well. Avoid placing samples with high signal
intensities next to no template control wells.

b) PCR contamination Use sterile pipet tips with filters. Store and extract
materials such as specimens, plasmid controls,
and amplicons separately from PCR reagents.

Poor or unexpected sequence

Low quality of genomic  Low-quality genomic DNA can cause the PCR to

DNA fail. Analyze PCR samples using an
electrophoretic technique (for example, the
QIAxcel® System or agarose-gel electrophoresis).

“Check” or “failed” result

a) Rare allele variants not  Less frequent number of TA repeats not covered

defined in the assay by the Assay setup or by the standard “Sequence
setup to Analyze” can result in changed reference
pattern and “Check” or “Failed” quality
assessment.
b) Low peak height Handling errors in PCR setup or sample

preparation prior to Pyrosequencing can result in
low peaks. It is recommended to reanalyze the

sample.
c) High peak height The Pyrogram should be carefully compared to
deviation warning at the histogram, which can be displayed by a right
dispensation x click in the Pyrogram window.
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Comments and suggestions

High background

Incorrect storage of Store nucleotides at 2-8°C. Storage at
nucleotides —20°C can cause an increase in the background.

No signals in positive controls

a) Insufficient enzyme or ~ Make sure to fill the PyroMark Q24 Cartridge

substrate mix for all according to the “Pre Run Information” in the
wells “Tools” menu.

b) Reagents incorrectly Prepare the UGTTAT Pyro Kit reagents according
stored or diluted to the instructions supplied.
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Appendix A: Setting Up UGT1A1 Pyro Assays

Set up the assay for UGTTAT1 allele variants by using the PyroMark Q24
Software. Before running the UGT1AT assay for the first time, the assay file
needs to be set up as described below.

Procedure

UGT1A1 *28
1. Click = in the toolbar and select “New AQ Assay”.
2. Type the sequence “ATATAT[AT]GGCA"” in “Sequence to Analyze”.

3. Manudlly enter the following “Dispensation Order”;
“CATATATATGC".

4. Click the “Analysis Parameters” tab, and increase “Peak Height
Threshold - Required peak height for Passed quality:” to 30.

5. Click i in the toolbar, and save the assay as UGT1A1T *28.
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Figure 9. Histogram for genotyping of UGT1A1 allele variant *28.

UGT1A1 *6

1. Click =7 in the toolbar and select “New AQ Assay”.
2. Type the sequence “CRGAGCAT” in “Sequence to Analyze”.

3. Manuadlly add the following “Dispensation Order”;
“TCAGAGCA".

4. Click the “Analysis Parameters” tab, and increase “Peak Height
Threshold - Required peak height for Passed quality:” to 30.

5. Click  in the toolbar, and save the assay as UGT1A1 *6.
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Figure 10. Histogram genotyping of UGT1A1 allele variant *6.
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Appendix B: Emptying the Waste Container and
Troughs
WARNING | Hazardous chemicals

A The Denaturation Solution used with the vacuum workstation

contains sodium hydroxide, which is irritating to eyes and skin.

Always wear safety glasses, gloves, and a lab coat.

The responsible body (e.g., laboratory manager) must take the
necessary precautions to ensure that the surrounding
workplace is safe and that the instrument operators are not
exposed to hazardous levels of toxic substances (chemical or
biological) as defined in the applicable Material Safety Data
Sheets (MSDSs) or OSHA,* ACGIH," or COSHH* documents.

Venting for fumes and disposal of wastes must be in
accordance with all national, state, and local health and safety
regulations and laws.

* OSHA: Occupational Safety and Health Administration (United States of America)

t ACGIH: American Conference of Government Industrial Hygienists (United States of
America)

¥ COSHH: Control of Substances Hazardous to Health (United Kingdom)

Be sure to observe federal, state, and local environmental regulations for the
disposal of laboratory waste.

Procedure

1. Ensure that no vacuum is applied to the vacuum tool. Make sure that
the vacuum is closed (Off) and the vacuum pump is switched off.

2. Discard any solutions left in the troughs.

3. Rinse the troughs with high-purity water, or replace them if
necessary.

4. Empty the waste container.
5. The cap can be removed without disconnecting the tubing.

6. If the vacuum workstation must be cleaned (for example, due to dust
or spillage), follow the instructions in the PyroMark Q24 User
Manual.
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Ordering Information

Product Contents Cat. no.
UGTTAT Pyro Kit For 24 reactions on PyroMark 970540
(24) Q24 Systems: Seq Primers, PCR

Primers, Human Control DNA,
PyroMark PCR Master Mix,
CoralLoad Concentrate,
PyroMark Binding Buffer,
PyroMark Annealing Buffer,
PyroMark Denaturation Solution,
PyroMark Wash Buffer, Enzyme
Mixture, Substrate Mixture,
dATPaS, dCTP, dGTP, dTTP, and

H,O
Accessories
PyroMark Q24 Plate  24-well sequencing reaction 979201
(100) plate
PyroMark Q24 Cartridges for dispensing 979202
Cartridge (3) nucleotides and reagents
PyroMark Vacuum Reusable filter probes for 979010
Prep Filter Probe PyroMark Vacuum Workstation
(100) Q96 and Q24
PyroMark Control For installation check of system 979203
Oligo
PyroMark Q24 For performance confirmation of 979204
Validation Oligo system

Related products

PyroMark Q24 Sequence-based detection 9001514
platform for Pyrosequencing of
24 samples in parallel

PyroMark Q24 Vacuum Workstation for 9001518
Vacuum Workstation  preparing 24 samples in parallel, (220 V);
from PCR product to 9001516

single-stranded template (110 V);

9001519

(100 V)
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Product Contents Cat. no.

PyroMark Q24 Analysis software 9019062
Software
QIAamp DNA FFPE  For 50 DNA preps: 50 QlAamp 56404
Tissue Kit (50) MinElute® Columns,

Proteinase K, Buffers, Collection

Tubes (2 ml)
EZ1 DNA Tissue Kit  For 48 preps: Reagent Cartridges 953034
(48) (Tissue), Disposable Filter-Tips,

Disposable Tip-Holders, Sample
Tubes (2 ml), Elution Tubes
(1.5 ml), Buffer G2, Proteinase K

QIAamp DSP DNA  For 50 preps: QlAamp Mini Spin 61104
Blood Mini Kit Columns, Buffers, Reagents,
Tubes, VacConnectors

For up-to-date licensing information and product-specific disclaimers, see the
respective QIAGEN kit handbook or user manual. QIAGEN kit handbooks and
user manuals are available at www.giagen.com or can be requested from
QIAGEN Technical Services or your local distributor.
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Trademarks: QIAGEN®, QlAamp®, QlAxcel®, CoralLoad®, EZ1®, HotStarTaq®, MinElute®, Pyro®, Pyrogram®, PyroMark®, Pyrosequencing® (QIAGEN
Group); Milli-Q® (Millipore Corporation); Sepharose® (GE Healthcare); Windows® (Microsoft Corporation).

Limited License Agreement
Use of this product signifies the agreement of any purchaser or user of the UGT1A1 Pyro Kit to the following terms:

1. The UGT1A1 Pyro Kit may be used solely in accordance with the UGTTAT Pyro Kit Handbook and for use with components contained in the Kit
only. QIAGEN grants no license under any of its intellectual property to use or incorporate the enclosed components of this Kit with any
components not included within this Kit except as described in the UGTTAT Pyro Kit Handbook and additional protocols available at
www.giagen.com.

Other than expressly stated licenses, QIAGEN makes no warranty that this Kit and/or its use(s) do not infringe the rights of third-parties.
This Kit and its components are licensed for one-time use and may not be reused, refurbished, or resold.

QIAGEN specifically disclaims any other licenses, expressed or implied other than those expressly stated.

o » LN

The purchaser and user of the Kit agree not to take or permit anyone else to take any steps that could lead to or facilitate any acts prohibited

above. QIAGEN may enforce the prohibitions of this Limited License Agreement in any Court, and shall recover all its investigative and Court
costs, including attorney fees, in any action to enforce this Limited License Agreement or any of its intellectual property rights relating to the Kit
and/or its components.

For updated license terms, see www.giagen.com.
© 2011 QIAGEN, all rights reserved.



www.qiagen.com

Australia = Orders 1-800-243-800 = Fax 03-9840-9888 = Technical 1-800-243-066

Austria = Orders 0800-28-10-10 = Fax 0800-28-10-19 = Technical 0800-28-10-11

Belgium = Orders 0800-79612 = Fax 0800-79611 = Technical 0800-79556

Brazil = Orders 0800-557779 = Fax 55-11-5079-4001 = Technical 0800-557779

Canada = Orders 800-572-9613 = Fax 800-713-5951 = Technical 800-DNA-PREP (800-362-7737)

China = Orders 86-21-3865-3865 = Fax 86-21-3865-3965 = Technical 800-988-0325

Denmark = Orders 80-885945 = Fax 80-885944 = Technical 80-885942

Finland = Orders 0800-914416 = Fax 0800-914415 = Technical 0800-914413

France = Orders 01-60-920-926 = Fax 01-60-920-925 = Technical 01-60-920-930 = Offers 01-60-920-928

Germany = Orders 02103-29-12000 = Fax 02103-29-22000 = Technical 02103-29-12400

Hong Kong = Orders 800 933 965 = Fax 800 930 439 = Technical 800 930 425

Ireland = Orders 1800 555 049 = Fax 1800 555 048 = Technical 1800 555 061

ltaly = Orders 800-789-544 = Fax 02-334304-826 = Technical 800-787980

Japan = Telephone 03-6890-7300 = Fax 03-5547-0818 = Technical 03-6890-7300

Korea (South) = Orders 080-000-7146 = Fax 02-2626-5703 = Technical 080-000-7145

Luxembourg = Orders 8002-2076 = Fax 8002-2073 = Technical 8002-2067

Mexico = Orders 01-800-7742-639 = Fax 01-800-1122-330 = Technical 01-800-7742-436

The Netherlands = Orders 0800-0229592 = Fax 0800-0229593 = Technical 0800-0229602

Norway = Orders 800-18859 = Fax 800-18817 = Technical 800-18712

Singapore = Orders 1800-742-4362 = Fax 65-6854-8184 = Technical 1800-742-4368

Spain = Orders 91-630-7050 = Fax 91-630-5145 = Technical 91-630-7050

Sweden = Orders 020-790282 = Fax 020-790582 = Technical 020-798328

Switzerland = Orders 055-254-22-11 = Fax 055-254-22-13 = Technical 055-254-22-12

UK = Orders 01293-422-911 = Fax 01293-422-922 = Technical 01293-422-999 ... ..

USA = Orders 800-426-8157 = Fax 800-718-2056 = Technical 800-DNA-PREP (800-362-7737) QIAGEN

Sample & Assay Technologies



